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By Paul Howard
At our April meeting, Bill Walsh 
donned the mantle of “White 
Knight” and fi lled in for an ailing 
Bob Mason, whose back turned left 
when he turned right.  We wish 
Bob a full and speedy recovery.  Bill 
presented an interesting discussion 
on recording or “burning” quality 
DVDs, based on research he’d been 
working on for several months.  
Geof Goodrum fi lled the remain-
der of the afternoon’s program with 
a presentation about Internet com-
parison shopping web sites.  Hand-
outs and slides from both presen-
tations are available on the “recent 
meetings” page of the web site at:    
http://www.wacug.org/recmtgs.
html 

During the meeting’s Q&A session, 
items discussed included: Intuit’s 
plan to off er refunds of electronic 
fi ling fees to customers impacted by 
server problems around the federal 
fi ling deadline; the release of the 
Th underbird version 2.0 mail client 
from Mozilla.org; Dell and several 
other manufacturers are off ering 
the opportunity to buy new com-
puters with Windows XP installed, 
rather than Vista; and the Scantips.
com web site was suggested for help 

with scanning photographs and 
other materials.
Our May 12th (2nd Saturday) meet-
ing will be centered on photograph-
ic topics, a favorite subject based on 
membership surveys of  interests.  
WAC member Lorrin Garson will 
discuss “Photography Challenges 
in Travel.” Traveling presents a 
number of challenges for taking 
photographs, whether using tra-
ditional fi lm or digital equipment.  
Arctic and equatorial climates off er 
special challenges. Religious views 
in Muslim countries, cultural diff er-
ences and political situations present 
other challenges. Photographing 
children and other wild animals can 
be stimulating and frustrating. Be-
sides cameras, what other equipment 
should you take?  In what ways are 
fi lm and digital photography alike?  
Are there any special considerations 
for travel outside the U.S.? What 
special considerations are there 
in using digital equipment? How 
can you get decent photos in bad 
weather (rain, snow, etc.)?  Primary 
focus will be on amateur photogra-
phy with both point-and-shoot and 
SLR cameras, but with emphasis on 
the latter.  Sample photographs will 
be shown.

See PBits page 2
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Lloyd’s Web Sites for May, 2007
by Lloyd Johnson, WACUG Member 

http://www.wacug.org/ is the URL for the Washington Area Computer 
User Group. Visit it for past issues of Web Sites with hyperlinks

. Get added Sun protection by adding RIT  SunGuard to clothing 
— www.sunguardsunprotection.com

. Want a job?  Help family-owned business function well and deal 
with succession planning — www.ffi.org

 Also, provide administrative support for companies — www.ivaa.org 
also www.businesswheel.org/ search for “virtual assistant

. Guide to Municipal, Zero-coupon and other types of bounds —
www.investinginbonds.com

. Parent/teacher Web site for high-quality homework reference 
material and project ideas — http://www.thegateway.org 

. Exploring the Planets — http://www.nasm.si.edu/ceps/etp/

. KiloWatt.  Method of calculating a specific appliance electricity 
costs.  Multiply the appliance wattage ( found on back of its 
nameplate) by the number of hours you use it per day, then multiply 
by the number of days you use it per year.  Divide that total by 1000 
and multiply by utility company’s kilowatt charge (6.97 cents per kwh 
–for Dominion).  A 200 watt fan running 4 hours/day for 120 days 
costs $6.69 per year.

. Your car wasn’t built for the way many people drive.  Stop-and-go 
traffic, etc.  For a typical maintenance and repairs you likely will need 
go to — http://carcare.org/index.shtml

. Free books, articles, short stories etc — www.YouGetInfo.com
 Postal Rate Increase.  On 14 May 2007 cost of a first class stamp will 

be 41 cents, up from 39 cents.  After 12 April 2007 you can buy a 41 
cent “forever stamp” that will be valid no matter how much rates go 
up in the future.

. You may not have to pay old debts.  All states have statue of 
limitations for debt collection. — http://www.creditinfocenter.com

. Type in the common name of a flower and within seconds up pop 
enlargeable photos of the flower along with its scientific name and 
where it grows.  Try begonia — http://elib.cs.berkeley.edu/flowers

.  Major League Baseball Stats for pre 1984 — http://retrosheet.org
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NCTCUG
Visit our “sister” user group. 
The National Capital Tech-
nology and Computer User’s 
Group meets the first and 
fourth Wednesday of the 
month. They meet in Carlin 
Hall in Arlington at 5711 
South 4th Street. Visit their 
web site for more informa-
tion, a map and directions:

http://www.nctcug.org/
Meetings start at 7:00 PM

Washington Area User Group Partners
Working Together For Our Members

CPCUG       NCTCUG       WACUG

Shooting Camera Raw and 
Digital Asset Management by 
Chuck Roberts 
Professional photographers are mi-
grating to shooting camera raw 
images. What is camera raw and 
why are they switching to it? Is this 
important to me? What’s the ben-
efit of shooting camera raw? Chuck 
will demonstrate camera raw im-
ages and how to deal with them 
using Photoshop Elements 5.0 and 
Photoshop Lightroom for digital 
photographers. In addition, he’ll 
demonstrate  how both Photoshop 
Elements 5.0 and Lightroom help 
with digital asset management 
(managing your photos) to assist 
you in locating that special photo 
you’re searching for in your digital 
collection of 5000 photos (and still 
growing). How many digital images 
do you have?
These topics and our usual Q&A 
help session will be the highlights 
of our May meeting – you can’t af-
ford to miss it!
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GNU/Linux SIG
by Geof Goodrum

Geof has been under the weather 
since the April meeting and has 
been unable to write his regular ar-
ticles for the May issue.
We all wish Geof the best and look 
forward to his articles returning in 
the June issue.
Geof, hurry up and get better will 
ya? We miss you and your stuff!



Diskeeper 2007 Pro 
Premier —  
Enhancing File System 
Performance – Automatically

By Verne Perry, PCC Member

First off, I’m not very 
impressed by the recent 
release of Windows Vista, 

primarily because I vainly hoped 
that with this Windows version, 
Microsoft would finally solve its file 
system problems. It didn’t. So on my 
Windows machines I’ll continue to 
have to worry about the eventual  
sluggishness that results from the 
file fragmentation that occurs just 
with use of the machine. Between 
home and the office I maintain 8 
XP machines, and one Windows 
98 machine, that acts as a server, 
and to keep all of these machines 

running smoothly I spend a lot of 
time routinely defragging them. I 
found long ago that using Windows 
Defragger was an extremely slow 
process, and over the years developed 
a maintenance routine which 
involved using windows checkdisk 
to check the disks on boot-up along 
with using a freeware program called 
SpeeDefrag 4.1, which would then 
defrag the disks prior to any drivers 
or startup programs being loaded. 
But the process is not automatic, and 
often my procrastination in actually 
starting the process resulted in the 
machine getting so defragged that 
there was a noticeable performance 
drag.

So I was happy to receive a copy 
of Diskeeper 2007 Pro Premiere 
to evaluate. The Diskeeper promo-
tional materials said that this ver-
sion introduced a major new feature 
called “InvisiTasking”, a proprietary 
feature that transparently runs in 
the background and that this “on 
the fly” defragmentation used “very 
close to zero” resources and was in-
visible.
Indeed, InvisiTasking was described 
as being the “essence” of the prod-
uct. Moreover, Diskeeper’s older 

“I-FAAST” (Intelligent File Access 
Acceleration Sequencing Technol-
ogy) file system performance tech-
nology which is designed to bench-
mark hard disk volumes for their 
performance characteristics and 
continually monitor them to deter-
mine which files are requested most 
often, was integrated with the oper-
ation of the “InvisiTasking” product. 
For safety, Diskeeper 2007 moves a 
file only when it is absolutely cer-
tain that no data will be lost using a 
“Movefile” application programing 
interface (API) jointly developed 
with Microsoft. Although manual 
defragmentation with Diskeeper is 
still possible, it is not the way the 

product is now intended to be used.
I decided to test Diskeeper on my 
home XP machine, because it’s the 
one that has the highest rate of de-
fragmentation, due to my frequent 
installation and uninstallation of 
various test programs. That ma-
chine also has a Linux partition 
which I wanted to use as a “curve 
ball” thrown into my testing. Other 
than the “curve ball” Linux parti-

See Diskeeper 2007 page 4
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tion, the machine’s other hard disk 
partitions were formatted in NTFS, 
for which “InvisiTasking” and “I-
FAAST” technologies were opti-
mally designed.
The first thing that Diskeeper did 
when I installed it was to analyze 
all of the Windows hard disk vol-
umes. I was pleased that it skipped 
the “curve ball” Linux volume, since 
I wouldn’t want Diskeeper dealing 
with that volume anyway. It also re-
ported that my C:\ drive was heav-
ily fragmented, which I expected. 
However, I was surprised that the 
analysis included a report generated
by the FRAGSHIELD feature 
of the program, advising that the 
drive’s Master File Table (MFT) 
was using 86% of the total MFT 
size and was likely to become frag-
mented. Despite having previously 
tested a fair number of defragmen-
tation programs (both commercial 
and freeware) I had never before 
seen such a test or option to op-
timize the MFT. Windows XP 
initially establishes the size of the 
MFT, but as more files are placed 
on the disk the MFT may fill up, 
and when XP increases the size 
of the MFT to accommodate the 
needed additional indexing, the 
increase usually results in a frag-
mented MFT. Because the MFT is 
an index of all the files on the disks 
(working in much the same way that 
phone book stores phone numbers), 
a fragmented MFT will cause a dis-
proportionate amount of file perfor-
mance degradation. So I decided to 
follow Diskeeper’s recommendation 
to increase size of the MFT to cor-
rect this problem, as well as to do 
a boot-time defrag of the increased 
MFT and the windows pagefile. I 
also decided to thoroughly test the 
“on the fly” “essence” of the new ver-

sion by setting all my drive volumes 
for automatic defragmentation.
Despite my initial skepticism about 
an “on the fly” defragger, my experi-
ence with Diskeeper was very posi-
tive. Immediately after completing 
the initial set up I decided to put the 
“on the fly” features to an immedi-
ate test. In my experience, playing a 
fast paced first person shooter game 
is an excellent way to test the drag 
imposed by a program running in 
the background, so after the initial 
setup I immediately fired up Unreal 
Tournament 2004 for a two hour 
test session. I noticed a drag for 
nearly the whole session, but in the 

three weeks since that initial test, I 
have played the same game and also 
done other things, trying to detect 
a drag from Diskeeper’s “on the fly” 
defragmentation. Since that initial 
session, I have detected no drag 
whatsoever. On the other hand, I 
have noticed that my machine is 
running much smoother, faster, and 
otherwise free from any symptoms 
of fragmentation. Finally, I ran the 
Analyze feature on all my hard disk 
partitions, and found that in the 
three week period there was essen-
tially no new fragmentation.
I also tested Diskeeper on an ex-
ternal USB drive formatted with 

NTFS. Diskeeper was able to ana-
lyze and defrag the drive. Although 
the analysis indicated that the ex-
ternal drive’s MFT needed to be 
increased, I knew that would be im-
possible because there is no practical 
way to perform a boot time defrag 
on such an external drive.
I’d say that as long as Windows con-
tinues to use the NTFS file system, 
which requires periodic defragmen-
tation, I would highly recommend 
Diskeeper 2007 Pro Premiere, 
which is priced at $99.99. You can 
do your own test by downloading a 
free 30-day full trial version from 
the Diskeeper.com web site.
Installation requires an XP or 2000 
operating system and at least 11 
MB of disk space. There is also a 
Pro version for $49.99 (which does 
not have the integrated I-FAAST
feature, but does have the FRAG-
SHIELD) and the Home version 
which does not have either the I-
FAAST or the FRAGSHIELD 
feature). As for Vista, existing Dis-
keeper 2007 customers can go to 
the web site to receive a free link 
to download a Vista-only version, 
and new customers can purchase 
the Vista-only version. Of course 
another solution is for the business 
world to go to an Operating System 
that doesn’t have these archaic file 
system problems. How about some-
thing called Linux?
This article may be published only by 
APCUG member user groups. All other 
uses are prohibited. When used, APCUG 
must be acknowledged as the source and the 
author credited. The Editorial Committee 
of the Association of Personal Computer 
User Groups (APCUG), an international 
organization of which this group is a mem-
ber, brings this article to you.
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Adobe Photoshop 
Elements 5 — A 
Software Review 

by Nancy Dennis, Membership 
Chair, Sarasota PCUG, Florida

www.spcug.org
membership(at)spcug.org

Adobe Photoshop Elements 
5 is a photo editing and 
organizing program that 

also includes easy to use features to 
backup your photos, and really fun 
creative ways to show off your pho-
tos to family and friends. 
Adobe Photoshop is the top of the 
line photo program for the profes-
sionals and costs hundreds of dol-
lars. Elements (under $100) has 
many of the same features as the 
professional version with a lot of fun 
and easy features added in, making 
it the software choice for the non-
professional user like you and me.
The software installs the Adobe 
Photo Downloader in your system 
tray and is ready instantly whenever 
you plug in your camera or memory 
card. Your photos are downloaded 
into the Organizer where you have 
easy access to them for viewing, 
tagging, creating collections, print-
ing, emailing, creating all the fun 
projects, or switching to the Edit 
mode for a Quick Fix or Full Edit. 
Your photos are identified by Ele-
ments in Catalogs. You can have 
multiple catalogs for different us-
ers of your computer in the family, 
or say for photos that you may use 
for work which you want to keep 
separate from home photos. You 
can even use the Organizer to select 
photos to order prints online or size 
and send through your email client. 
Your photos are managed by date 
with a timeline across the top of the 
screen that is very easy to navigate 
when you are looking for a photo 

at a specific time on the calendar. 
The Tags and Collections feature 
takes a few extra minutes when 
you first download the photos, but 
sure makes it easier to select certain 
photos when you are ready to cre-
ate a project. Tags can be given for 
photos of specific family, friends or 
places and events. Collections work 
in a similar fashion but could in-
clude several different people, say in 
a vacation.
Since software packages come with 
little or no manuals, I find that one 
of my first places to explore is the 
Help feature. The Adobe Help Cen-
ter, which is on the Help menu, in-
cludes a very extensive index of help 
on the program as well as hyperlinks 
to video tutorials on the Adobe web 
site.  The Help Center includes a 
very good Search tool with easy 
navigation and even a Bookmark 
feature where you can bookmark a 
topic that you may want to return 
to again quickly. I was also offered 
free online tutorials from Adobe 
after I registered the software. Be 
sure to take advantage of this offer. 
There are eleven video tutorials that 
give a very good overview of every-
thing from getting your photos into 
Elements to creating fun creative 
projects. Another quick way to get 
to help on any of the tools on the 
screen is to hover your mouse over 
the tool and a link appears that 
takes you directly to the Help Cen-
ter on that tool. You will find that 
you don’t miss the manual with this 
complete Adobe Help Center.
When the Elements program starts 
there is a Welcome Screen where 
you can choose to open the Orga-
nizer, Quickly Fix Photos, Edit and 
Enhance Photos, or Make Photo 
Creations. Once you decide which 
mode you want to begin with you 
can set the Welcome Screen to al-

ways open in that mode or stay with 
the Welcome Screen. Since you need 
to open a photo in order to edit it or 
select several photos for projects it 
made sense to me to always open in 
the Organizer mode. 
With a right click of a photo in the 
Organizer you can select the Go to 
Quick Fix feature as a truly “quick 
fix”. With this feature you are able 
to fix the most common problems 
with your photos without having to 
know any of the more advanced fea-
tures. Now mind you the advanced 
features are in Elements, but you 
may find that you seldom need to go 
into that mode to get the results that 
you want. With Quick Fix mode 
you have auto buttons for lighting, 
color, sharpen and red eye. Then if 
the auto button doesn’t quite get the 
photo like you want there are fine 
tuning levers to adjust to finish the 
job. If you just can’t get the look you 
want you can click the Full Edit tab 
from this window and go into the 
more fully featured mode of Ele-
ments to complete the task.
Some of the new features for edit-
ing in Elements include correct lens 
distortion, sharpen blurred edges, 
fine-tuning with curves, creating 
dramatic black and whites and sup-
port for raw files. One of my very 
favorite features of Elements in 
the Full Edit mode is the Artwork 
and Effects Palette. From this pal-
ette you can pick from dozens of 
backgrounds, frames, graphics and 
shapes. Then select a style for that 
object from a dozen more selec-
tions and just drag and drop onto 
your photo. This palette includes 
different themes for effects, filters 
for effects and text styles, all ap-
plied with a double click. There 
is even a Favorites area where you 
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can drag an effect that you espe-
cially liked and want to get back to 
quickly. A couple other favorites of 
mine in the Full Edit mode are the 
Adjust Color for Skin Tone and the 
Spot Healing Brush.  If you have 
a photo where the skin color just 
doesn’t look right you can use the 
Adjust Color for Skin Tone feature 
to quickly change the skin tone by 
using the eyedropper over the skin. 
If you want the result a little more 
tan or blush there are easy adjust-
ments in that same dialog box. The 
Spot Healing Brush works wonders 
for those marks and blemishes just 
by clicking over the area. There is 
also a new feature called Magic Ex-
tractor that provides an easy wiz-
ard to extract an object (or person) 
from your photo. Again there are 
fine tuning options in this wizard 
if the extraction is not quite what 
you want. I found that this features 
works very well. The red eye fix in 
Elements 5 is by far the best red 
eye fix that I have used in a photo 
editing program. There is even an 
option to have red eye corrected as 
your photos are being downloaded 
from the card reader.
Elements 5 has added a Back-Up 
and Restore feature that allows you 
to back up your photo catalogs to a 
server online (you have to sign up 
for this service). The online back up 
service through Adobe Photoshop 
Services gives you a 30 day free tri-
al. There is also a Back-Up feature 
that will do Full and Incremental 
back ups of your catalogs to a CD 
or DVD, another drive, or another 
folder on the hard drive. This fea-
ture is Wizard driven and makes 
this very important task quick and 
easy, without leaving the Elements 
software. This feature is right there 
on the tool bar along with all the 

PSE 5 from page 5 other online services.
Once you have your photos down-
loaded, edited and backed up it is 
time for the really fun part of El-
ements 5 – creating projects like 
photo book pages, photo layouts, 
album pages, greeting cards, CD 
and DVD jackets and labels, slide 
shows, VCD’s with menus, photo 
galleries and flipbooks for the web, 
photo calendars, and PhotoStamps. 
Most of the print projects can be 
printed on your own printer or or-
dered through an online service 
that can be set up with a wizard 
right in Elements. I didn’t register 
for the online service but was very 
tempted by some of the neat proj-
ects that can be created and then 
sent off for printing and delivery. 
For instance the photo calendar can 
be created with 12 of your photos 
and then step through the wizard to 
choose the cover, page layout, and 
title, etc. Then through the wizard 
the calendars will be printed, bound 
and mailed – what a great idea for 
Christmas gifts!
I decided to create a slide show with 
photos taken at Disney World. After 
selecting the photos from the Orga-
nizer and then selecting Slideshow 
from the Create menu the wizard 
started with slide show preferences 
and then the main Slideshow Edi-
tor opens with very full featured 
options that are available in most 
of the stand alone slide show pro-
grams. This feature is like a pro-
gram within a program – I am re-
ally impressed with the scope of the 
Slideshow Editor. There are transi-
tion options, panning and zooming, 
audio and narration, and adding 
blank sides and graphics and text. 

See Figure 1 on page 7
Once you have the show the way you 
like it the Output feature opens an-
other wizard for options to save the 

show as a file, burn to disc, e-mail 
the show or send to a TV. The wiz-
ard works great burning to a Video 
CD format. (The only option that I 
would like to see added would be to 
burn to DVD.) If you have several 
slide shows that you would like to 
burn to one CD you can select the 
Create a VCD with menu and the 
wizard will allow you to add mul-
tiple slideshows and then create a 
menu before burning. 
The next project I tried was to cre-
ate a Photo Gallery. With the same 
Disney photos selected the Photo 
Gallery opens a wizard with three 
types of galleries; Web Galleries, 
Animated or Interactive. With Web 
Galleries chosen the wizard asks for 
arrangement of the photos on the 
page and a style with both options 
showing thumbnails of how your 
choice will look. Next the wizard 
opens a dialog window with more 
options to customize, such as Gallery 
Title and Slideshow duration and 
effects. You then can select where to 
Share the gallery; either choose Do 
Not Share (which saves to your hard 
drive), Photoshop Showcase (more 
about this later), My FTP Site, or 
CD. I also tried the Animated and 
Interactive galleries with the same 
photos. The wizard makes creating 
these very complex shows a breeze. 
If you don’t know how to publish to 
your web space a dialog box offers 
simple steps to help with that task, 
or you can register and sign on to 
the free Adobe Photoshop Elements 
Showcase feature. This is an online 
community for users of Elements to 
upload and share their photos and 
galleries.
Each project that you create and 
save is added to the Organizer at 
the top. If you want to edit a proj-
ect you just double-click the project 
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file and the wizard that was used 
to create it opens. All of the print 
projects like the Photo Book Pages, 
Photo Layouts and Album Pages, 
are saved (with multiple pages when 
applicable) with a .pse extension.  
The print projects are wizard driven 
and offer step by step selections for 
size, layout, theme and then ad-
ditional options depending on the 
project chosen. I decided to make a 
print project of a CD cover and la-
bel for the Disney slide show that I 
created earlier. The wizard walked 
me through the entire process open-
ing Elements in the Full Edit mode 
with my selected photo and all the 
layers in the layer palette created – it 
truly seemed like magic. Since you 
are left in this mode you can then 
adjust or fine tune the project before 
saving and printing it. 
One feature that I was not able to 
try but may be of interest to some 

reading this review is the ability to 
download and upload photos from a 
mobile phone.
I highly recommend Adobe Pho-
toshop Elements 5. There is an up-
grade rebate in the box of $20, so 
if you are using an older version 
you can take advantage of that. 
The price today at Amazon.com is 
$69.99 with free shipping and your 
$20 rebate makes the total price 
$49.99. There are other special of-
fers at local stores and online. Visit 
Adobe’s web page www.adobe.com 
for system requirements.
This article may be published only by AP-
CUG member user groups. All other uses 
are prohibited. When used, APCUG must 
be acknowledged as the source and the au-
thor credited. The Editorial Committee of 
the Association of Personal Computer User 
Groups (APCUG), an international orga-
nization of which this group is a member, 
brings this article to you.



McAfee SiteAdvisor
By Sandy Berger, CompuKISS

www.compukiss.com
Sandy(at)compukiss.com

Anyone who has been on the 
Internet for a while real-
izes that even websites that 

look benign can generate viruses, 
adware, spyware, spam, and scams.  
Until now, it was difficult to deter-
mine which websites to avoid. Now, 
however, safe surfing just got easier. 
Now there is a wonderful free pro-
gram that warns you about danger-
ous websites.
The McAfee SiteAdvisor is a small 
piece of software that works with 
your Internet Browser (either Inter-
net Explorer or Firefox). It tells you 
in an easy graphical format which 
websites are safe and which harbor 
spyware, viruses, excessive pop-ups, 
or online scams.
McAfee has a system of automated 
spiders that patrol the Web con-
stantly checking out websites. They 
assess the safety of each website in-
cluding how much spam is generat-
ed from signing up for information 
at that site and how much spyware, 
adware, and other nasties might be 
attached to downloads from that 

See Site Advisor page 8

Figure 1

http://www.compukiss.com
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Site Advisor from page 7 puter in the world to come in. Ac-
tually, you have more than 65,000 
doors into your computer, any one 
of which may be open. That is, un-
less you have taken steps to keep 
these doors closed. That is the pur-
pose of a firewall. The firewall filters 
the information packets that show 
up at your “door” or computer port 
as we usually refer to it, and can ei-
ther prevent them from entering or 
pass them through. 
When your computer connects to 
the Internet, it is assigned a nu-
meric address or IP (internet pro-
tocol) address. These addresses are 
a 32 bit number. They usually writ-
ten out in four groups with peri-
ods between each group as follows:  
111.11.11.111.  Traveling over the 
Internet are many programs that 
simply look for unprotected IP ad-
dresses. The IP address of any un-
protected computer is sent back to 
the originator who can then upload 
a trojan or spyware package to that 
address. The originator can then 
take control of  the computer or the 
application will record keystrokes 
and send all recorded information 
back to the program originator. 
Although your computer has one 
IP address there are many different 
ports on your address. There are dif-
ferent ports for different purposes on 
your computer. Your connection to 
the Internet is usually through port 
80. This is referred to as the HTTP 
(hypertext transfer protocol) port. It 
is used when you connect to a web 
page. The web page data is down-
loaded to your computer through 
this port. Another commonly used 
port is 25. This is used for the SMTP 
(standard mail transfer protocol) or 
e-mail transfer. Another port is used 
for incoming mail or POP3 transfer 

See Firewall page 9

site. The SiteAdvisor will also alert 
you to sites with excessive pop-ups 
and those that are possible phishing 
sites. Besides the automated testing, 
McAfee has a team of individu-
als who assess the sites. They use a 
detailed analysis as well as feedback 
from individual users.
To use the SiteAdvisor, you simply 
download the free program.   The 
program is very small, so it down-
loads and installs quickly and it 
doesn’t slow down your Web surf-
ing.
After installation, a small SiteAd-
visor rectangle will appear either 
on the top (Internet Explorer) or 
the bottom (Firefox) of the screen. 
When you visit a site that SiteAd-
visor considers safe the rectangle 
turns green. Sites that have serious 
security problems will turn the rect-
angle red. A yellow rectangle means 
that the website may have some 
problems or issues. You can click on 
the SiteAdvisor symbol to get more 
information about the website that 
you are visiting and why it is consid-
ered safe or unsafe.
This information is invaluable when 
surfing the Web. With SiteAdvisor 
installed you don’t have to be fearful 
that signing up for more informa-
tion or a newsletter will set you up 
for spam. You don’t have to worry 
that downloading software will in-
stall spyware. In fact, SiteAdvisor 
takes much of the fear out of inves-
tigating and trying new things on 
the Internet.
Another great feature of the SiteAd-
visor program is that when you do a 
search on Google, Yahoo! or MSN, 
SiteAdvisor’s safety ratings appear as 
a red, green, or yellow circle next to 
the search results. You can easily see 
if a website is safe before you visit!! 

What a pleasant and useful service. 
If you want more information be-
fore you click on the search engine 
listing, just hover your mouse over 
the SiteAdvisor icon and a window 
will pop-up giving your details on 
the site’s ratings.
Everything that I just described 
about the SiteAdvisor is available in 
the free version. McAfee also offers 
a Plus version that is available for 
$19.99 per single user or as a 3-user 
family pack for $39.99. The Plus 
version offers even more peace of 
mind by alerting you to dangerous 
links in email and instant messag-
ing programs. The Plus version also 
has a password protected mode that 
can actively protect your computer 
against dangerous websites. This 
version is perfect for anyone who 
wants a little extra protection. It is 
also great for shared computers and 
computers that children or grand-
children use. Click here to down-
load the SiteAdvisor.
Obtained from APCUG with the 
author’s permission for publication 
by APCUG member groups
This article has been provided to 
APCUG by the author solely for 
publication by APCUG member 
groups. All other uses require the 
permission of the author (see e-mail 
address above).



Why You Need A 
Firewall
By Brian K. Lewis, Ph.D., Member 

of the Sarasota PCUG, Florida
www.spcug.org

bwsail at yahoo dot com

When you connect your 
computer to the Inter-
net, you have opened a 

door which invites any other com-

 http://www.siteadvisor.com/download/ffmedia.html?cid=21638&gclid=CPLL-7C95YsCFRmxgAodlE8RPQ
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is port 110. These are all part of the 
port series from 0 to 1024 that are 
the most common ports.  Many ap-
plications use ports in this region 
including PC Anywhere, Internet 
telephones, MSN messenger, Net 
Meeting, and all AOL operations. 
Ports 1024 to 49451 are referred to 
as registered ports. There are many 
Internet games that use ports in this 
region. There are also other specific 
functions assigned to these ports 
and some may duplicate functions 
in the common port region. The fi-
nal group of ports are dynamic and 
have no specific functions regis-
tered. However, the point is that all 
of these ports can be accessed by re-
mote computers somewhere out on 
the Internet and use them to con-
nect to your computer if you have 
not protected them.
Automated port scanning software 
is available free on the Internet from 
many “hacker sites”. Its use is very 
common on the Internet. There are 
various types of scans. Some scan-
ners will look for any of the 65,535  
possible ports. Another type looks 
for open UDP (user data protocol) 
ports or may use an FTP (file trans-
fer protocol) bounce to hide the ori-
gin of the scan.  If an open port is lo-
cated, software can be downloaded 
that will open a “backdoor” on your 
computer. This allows remote input 
and output. Such access can be used 
to record and transmit out informa-
tion from your computer. It can also 
be used to attack other computers to 
produce a “zombie” network. Such 
networks have been used to attack 
large computer servers in attempts 
to bring them down or to produce a  
“denial of service” attack. 
Many users believe that a router 
with a firewall is adequate protec-
tion. Most routers use either net-

work address translation (NAT) or 
a packet filter. Information on the 
Internet is transmitted in packets 
which contain the IP address of the 
sender and the address of the re-
ceiver in addition to the data. The 
routers firewall uses filters that look 
at the sending and receiving ad-
dresses of incoming packets on port 
80 (HTTP). Only those packets 
that are a response to an outgoing 
request are allowed through. If your 
router uses a packet filter it can be 
penetrated by a fragmented scan. 
This type of scan breaks up pack-
ets into fragments which can easily 
get through the simple packet fil-
ter found in most router firewalls. 
Routers using NAT either alone or 
in combination with a packet filter 
can also be easily thwarted. NAT is 
not successful when the packet is an 
FTP packet or is sent by Microsoft’s 
Netmeeting or similar audio/video 
applications that bury the address in 
the body of the packet. Only when 
the address is in the header of the 
packet can the router  use address 
substitution. So packet filtering and 
NAT, although useful, do not pro-
vide complete firewall protection for 
all Internet connections. 
Another method for preventing 
intrusions is “stateful” packet in-
spection. This is the method used 
by most software firewalls and is 
found is some of the newer rout-
ers. When your web browser opens 
a connection to the Internet, the 
firewall software records that con-
nection and keeps a record of its 
status. Whenever a packet arrives 
at your computer, the data in the 
packet can be compared to the  in-
formation in the firewall state table. 
The firewall software can also make 
decisions based on the data content 
of the packet, not just the sender’s 
address. Because this examination 
does require some time there may 

Firewall from page 8 be a slight slowdown of your sys-
tem. However, in most cases, there 
will not be a long enough delay for 
most users to notice.
So inbound packets can be filtered 
and examined for dangerous con-
tent. However, when the user con-
nects to a web server, the page re-
quested is downloaded to the users 
computer. It is possible for that web 
page to contain a small program or 
a link to a dangerous site in a one 
pixel unit on the page. When this 
is downloaded the program is run 
or the link activated.  This results in 
an outgoing packet to some Internet 
address through a non-standard port 
so the user is not aware of the activ-
ity. This type of activity would not 
be stopped by a hardware firewall in 
a router. It can only be blocked by a 
software firewall which recognizes 
that this activity is coming from a 
new application that has not previ-
ously made an Internet connection. 
In this case the software will query 
the computer user to determine if 
this new application should be al-
lowed to connect. Hopefully, the 
user would recognize that this was 
not an application that the user was 
running and the outbound packet 
would then be blocked. It is abso-
lutely necessary for the firewall to 
process both incoming and out-
going packets. Only a software 
firewall can establish the necessary 
tables for comparing the incoming/
outgoing packets to allowed activity 
and request user interaction when 
necessary.
This leads us to the Windows 
firewall. This firewall, as used with 
Windows XP, does not have any 
control of outbound packets. Any 
application is allowed to connect to 
the Internet without any filtering or 
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other checking of source or content. 
Windows Vista was supposed to 
come with both inbound and out-
bound filtering. However, as it is 
delivered it provides only inbound 
protection just as did XP. The out-
bound protection is turned off by 
default. So, if it is there, how do 
you turn on the outbound protec-
tion. To change this you have to use 
the Microsoft Management Con-
sole. Then you have to write a rule 
to block each “malware” application 
you anticipate might get on your 
computer. You can not create a gen-
eral rule for all malware. Creating 
rules that would cover all possible 
malware applications is an impossi-
ble task.  Microsoft has been quoted 
as saying “outbound filtering isn’t 
really needed, and the key is mak-
ing sure that malware doesn’t infect 
the PC in the first place.”  Also they 
have stated that large enterprises 
had requested that it be turned off 
by default. Microsoft does say that 
“core Windows Services have spe-
cific behaviors which are monitored 
by the firewall”. Instead of using 
outbound filtering Microsoft rec-
ommends that you buy “Windows 
Live OneCare”, a product and sub-
scription service. My recommenda-
tion is that you obtain a free two-
way firewall like ZoneAlarm and 
ignore the Windows firewall com-
pletely.
Whatever you do, don’t connect 
your computer to the Internet with-
out using a firewall and an antivi-
rus application. I have come across 
too many computers recently that 
are attached to constant on Internet 
connections and had no protection. 
The cost of removing the malware 
from these systems was more than 
the cost of premium protection. So 

don’t get caught short!
Dr. Lewis is a former university & medical 
school professor. He has been working with 
personal computers for more than thirty 
years.  He can be reached via e-mail: bwsail 
at yahoo dot com.

Obtained from APCUG with the author’s 
permission for publication by APCUG 
member groups.

This article has been provided to APCUG 
by the author solely for publication by AP-
CUG member groups. All other uses re-
quire the permission of the author (see e-
mail address above).



ter. This makes the file “invisible” 
to windows, and if Windows needs 
the space for something else, it has 
no qualms about overwriting your 
valuable data.  
What this means is that if you ac-
cidentally delete a file, you have a 
limited amount of time to recover 
it before windows stores something 
else over the same space. It may not 
happen right away, but it will hap-
pen eventually.  
Since there is no way within XP to 
recover a lost file, you have to turn 
to a third party solution. The good 
news is that there are several excel-
lent programs that will do the job 
easily. The even better news is that 
these programs are free. Isn’t that 
nice?  
Use Google or your favorite search 
engine to find FreeUndelet, PC In-
spector File Recovery, or Undelete 
Plus. All of them work well though 
you may find one easier to use than 
another. That’s a matter of personal 
preference.  
You need to be cautious about this. 
If you download the utility directly 
to your hard drive, you run the risk 
of storing the undelete program 
over the very data you are trying to 
recover. If you have a second hard 
drive, you can download to that or 
better yet, download directly to a 
thumb drive. That avoids all danger 
of losing important data, and it has 
the additional advantage of imme-
diate portability.  
The programs all work similarly. 
Direct any of the programs to a spe-
cific disk and you will get a list of 
all deleted recoverable files on the 
drive. You may also get a descrip-
tion alerting you that the file(s) may 
be wholly or partially recoverable. 
That’s good to know. ...Edited to fit



Recovering Files 
from a Hard Drive

By Vinny La Bash, a Member of 
the Sarasota PCUG, Florida

www.spacug.org
labash(at)spcug.org

Have you deleted a file that 
you need and you don’t 
know how to get it back? 

The first step is to make absolutely 
sure that it has been deleted. Open 
your Windows Recycle Bin and 
double-check. Is it in there? If so, 
simply right-click on the file and 
choose Restore.  
If you have emptied the Recycle 
Bin the next step is to restore the 
file from your latest backup. You do 
back up your data regularly, don’t 
you?   
Unfortunately, there is no native 
“Undelete” command in Windows 
XP. This is abysmal for Windows 
users, but profitable for third party 
software developers.  
It’s important to understand that 
when a file is deleted it is not ac-
tually removed from your system. 
Windows deletes only the first let-
ter of the file’s name and replaces it 
with a marked for deletion charac-
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Photoshop 
Workflow Setups

A Review by John Donan, a 
Member of the North Orange 

County Computer Club, CA
www.noccc.org

editor(at)noccc.org

I knew I had seen that girl be-
fore when I found her on the 
frontispiece facing Chapter 1. 

There are also eleven other excel-
lent full page images, some used in 

examples, five are 
facing the other 
chapters. I had 
seen the frontis-
piece on the Cre-
ativepro Website, 
under “Photo-
shop How-To: 

Tame the Beast,” (http://www.cre-
ativepro.com/story/howto/24366.
html) which turns out to be Chap-
ter 1 of the book which I also found 
at http://www.oreilly.com/cata-
log/photoworkflow/. I found these 
in my early research for the book. 
When I start a review, I browse for 
a cursory knowledge of a book’s 
content then I research the author. 
I also find comments of other re-
viewers in case there is something 
I might overlook. Eddie Tapp, this 
author, is an award-winning pho-
tographer, lecturer, consultant, 
and author on digital imaging is-
sues with over 20 years of experi-
ence in computer technology with a 
very impressive resume. From what 
Scott Kelby states on the cover, “If 
Eddie’s teaching a session, I want to 
be there!” it implies that teaching is 
one of his strong points.
A statement preceding Chapter 1 
says, “Adobe Photoshop has so many 
different work areas and tools that it 
can become confusing or even in-
timidating for digital photographers 
to use in a production environment. 

The fact is, there are only three par-
ticular zones or areas that you really 

need to 
become 
familiar 
w i t h : 
t o o l s , 
menu s , 
and pal-
e t t e s . ” 
U p o n 
examin-
ing my 
ver s ion 
of PS 
CS2, I 

find 58 tools and 198 menu items 
which include the choices for the 
19 palettes. Sixty of the menu items 
have further choices, as high as 20 or 
more in fly out menus as do all the 
palettes as well. Each of the tools 
has settings, relative to its func-
tion, which are made in its option 
bar. To place an order of magnitude 
on all this I assumed the number of 
secondary choices to be ten, it can 
easily be justified that there are over 
one thousand choices possible. You 
can add to this, keyboard shortcuts. 
There are 521 of them, I have count-
ed. What can be done in Photoshop 
seems unlimited when multiple 
processes are involved. I created an 
effect using an adjustment and a fil-
ter; when I reversed their order the 
result was entirely different. Com-
bine more than two such executions 
and the possible combinations and 
permutations grow tremendously. 
This is why the author says, “What 
is important is learning this infor-
mation one step at a time, finding 
the option or settings that are im-
portant to your workflow and then 
building from there.” This book in-
tends to make this humongous set 
of choices manageable. 
In 207 pages, the material covered 
had to be limited. Instead of pick-

ing apart a mass of nitty details the 
book provides guidance in overall 
effective usage. The book starts with 
efficient organization of the work-
space. Anyone using Photoshop 
knows how quickly palettes hog the 
visible area (Tools and Options are 
palettes by the way). I cleaned up 
my work space by his example most 
of which is ignored in teachings 
elsewhere. This first chapter covered 
using a second window (see figure 1 
which is typical of the illustrations 
of the book) and also tiling images, 
neither of which I had done previ-
ously nor had I ever considered the 
9 settings possible for the status bar, 
via its black triangle. The rest of the 
first chapter concerns the Bridge.

Figure 1, Photoshop opens a second 
window of your active image when 
you select Window > Arrange > New 
Window. It’s perfect when you want to 
do detail work and see the entire image 
at the same time.
About 20% of the book concerns the 
Bridge, Photoshop’s file browser. I 
had read where another Photoshop 
author refuses to use the Bridge be-
cause he feels it is yet too early in its 
state of development. This appears 
to be the case with my software for 
it will not open either Photoshop or 
JPEG images in Photoshop a fea-
ture of its main usefulness. To cor-
rect this will be expensive. Adobe 

See Photoshop Workflow Bonus Page 2

http://www.noccc.org
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technical support has told me that 
they require an advance payment of 
$39 to address either of these prob-
lems ($78). For those who are able 
to properly use the Bridge, or will-
ing to pay to make it work, it is cov-
ered in Chapter 5 of the book.
All palettes are covered and should 
one want to get a quick handle on a 
palette you don’t use, such as Layer 
Comps, the information is there. 
Although the information for this 
palette is held to one page, it is ad-
equate enough for me to have now 
mastered its use. The key palettes are 
stated to be these: Layers, Channels, 
Actions, History, Histogram, Color, 
Styles, Paths and the Info window. 
To unclutter his workspace, Tapp 
places his most active palettes in 
the Docking Well, cycling them as 
he needs them. By saving this con-
figuration, it is always available as a 
starting workspace at some future 
time. One of his notes in this part 
of the book introduced me to the 
Scrubby Slider. It has been in ex-
istence since CS. When the mouse 
cursor is in the vicinity of a slider 
label, it changes allowing the slider 
value to be changed without having 
to grab the slider exactly.
Preferences allow you to tailor your 
work to your needs. Of course some 
are more important than others. 
Chapter three considers those the 
author has found to be most im-
portant. As with other Adobe pro-
grams, the Preferences dialog box 
can be accessed via Ctrl-K. Nine 
dialogs are selectable. A point came 
up regarding image interpolation 
and the General Preferences dialog 
which is not widely known. For Im-
age Interpolation: Bicubic Smoother 
is designed for up-sampling images, 
while the Bicubic Sharper is de-
signed for down sampling images. 

Compared to some of my 600 page 
books, there is twice as much infor-
mation on preferences in this little 
guy
.The chapter “Customizing Key-
board Shortcuts and Menus” is brief 
(12 pages) but handy, should one 
want to specialize either of these 
for personal use. An adjustment, 
which I regularly use, is Shadow/
Highlight. It is also frequently used 
by the author. He has assigned 
for it the shortcut Shift+Ctrl+M 
which I have now also done, 
thanks to this chapter. Should I 
lapse into my old ways and traverse 
Edit>Adjustments>Shadow/High-
light the selection is handily high-
lighted in red (my choice.)
In the preface for the last chapter 
(Tapping into the Tools), the author 
states: “What is your favorite tool 
in Photoshop? Most people will 
say without reservation, the Clone 
Stamp tool. Yes, it’s a very powerful 
tool indeed, but the Clone Stamp 
tool can also be the most dangerous 
if it’s not used properly.” What he 
is referring to is repetitive patterns 
which aren’t seen until after the im-
age is printed. In slightly less than 
a page the use of this tool is com-
pletely covered. In fact this concise 
coverage brought home to me two 
features I had overlooked using.
I will continue using this book as a 
handy reference as can others whose 
PS skills may vary anywhere from 
beginner on. The book details are:  
Title: Photoshop Workflow Setups
Subtitle: Eddie Tapp on Digital 
Photography
First Edition: August 2006
ISBN: 0-596-10168-6
Pages: 207
MSRP=$30.
The book is available from O’Reilly 

at a discount of 35% to user group 
members. 
This article has been provided to APCUG 
by the author solely for publication by 
APCUG member groups. All other uses 
require the permission of the author (see 
e-mail address above).



Secure Your Flash 
Drive Cap

By Fran Damratowski. 
Refurbishing SIG Leader, 

Chesapeake PC Users Group, MD
www.chesapeakepcusersgroup.org

refurbishing(at)chesapeakepcusersg
roup.org

Have you ever misplaced 
your flash drive cap? No 
need to ever do that again. 

Secure it with a button. You will 
need:
— a shirt button, 
— some heavy thread such as 
carpet thread, 
— double sided self-sticking 
adhesive mounting foam, 
— double sided sticky tape, and
— some colorless nail polish.

1. Run the thread diagonally 
through two of the button-
holes and secure with a square 
knot. 

2. Place the knot on the top of 
the button not on the flat bot-
tom of the button. 

3. Cut the thread long enough to 
secure it with enough play to 
remove the cap. 

4. Cut a small piece of the dou-
ble-sided self-sticking adhe-
sive mounting foam about the 
size of the button. 

5. Remove the backing from one 

See Flash Drive Cap Bonus page 3
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side of the double-sided self-
sticking adhesive mounting 
foam and place a small piece of 
the double-sided sticky tape on 
the sticky side of the double-
sided self-sticking adhesive 
mounting foam. (The double-
sided self-sticking adhesive 
mounting foam does not hold 
well without the sticky tape. 
The tape alone does not hold 
well either.)

6. Securely attach the flat side of 
the button to the sticky tape. 

7. Trim the excess tape and 
foam using an x-acto knife. 

8. Remove the backing from 
the other side of the double-
sided self-sticking adhesive 
mounting foam and place 
another piece of double sided 
sticky tape on the foam. 

9. Securely attach the button 
foam and tape to the flash 
drive cap. 

10. Secure the other end of the 
thread to the flash drive or 
lanyard. 

11. Leave enough play to easily 
remove the cap, but not get 
tangled. 

12. Use the colorless nail polish to 

secure the knots so they don’t 
become undone. 

13. After the nail polish dries 
trim the thread. 

OR
You could go to your local photo 
shop and buy a $2+ button size lens 
cap keeper (or cap retainer) and 
modify it as needed. Most of them 
appear to come with elastic bands 
that are placed around the lens bar-
rel as opposed to a leash that can 
be attached to another part of the 
camera.

Obtained from APCUG with the author’s 
permission for publication by APCUG 
member groups. 

This article has been provided to APCUG 
by the author solely for publication by 
APCUG member groups. All other uses 
require the permission of the author (see e-
mail address above).



File Extensions
By Fran Damratowski, 

Refurbishing SIG Chair, 
Chesapeake PC Users Group, MD
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Have you ever wondered what 
the three alphanumeric ex-

tension at the end of a file name 
mean? (MS-DOS required file-
name to limited to eight characters 
for the base or root name and three 
characters for the extension. Win-
dows 95 and above no longer have 
that limitation.) The three letters 
or numbers are a way for the com-
puter user, software, and operating 
system to differentiate between and 
identify the program used to cre-
ate a file (document, spreadsheet, 
database, etc.). We are all familiar 
with .exe for an executable file, .txt 
for a text document, and .pdf  for 
a PDF file. There are many other 
file extensions. The same file exten-
sion may be used for more than one 
program. There is no standard or 
organization for creating file exten-
sions. This month we will begin to 
list some of the extensions.
Here is the A list of some of the 
extensions and the file types they 
represent. 

.a: An ADA program, Unix ar-
chive file, Macintosh assembly 
source code, Free Pascal Archive 
file for Linux or DOS
.a2b: A2B Player Playlist
.abx: Word Perfect Address Book 
file
.aby: AOL file
.adr: Address Book, Address Plus 
Database, After Dark Random 
Screen Saver Module, Opera , 
Smart Address adressbook, Web 
Browser Bookmark File
.albm: webAlbum Photo Album, 
Photosmart Photo Printing Al-
bum
.alz: ALZIip compressed file, 
game file
.aps: MS Visual C++ file, Flash 
(Italian), ArcPar Ver. 5 Symbol-
ogy, Advanced Patching Systems 
with Error Checking
.arl: AOL Organizer file
.arj: Compression archive
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•
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.ars: Adobe After Effects Render, 
Artifax Report Editor
.asl: Adobe Photoshop Layer file, 
Quest Adventure game, AppSight 
Console Log
.asm: non-unix assembler source 
file, Pro/Engineer Assembly file, 
LICOM AlphaCAM Stone Pa-
rameter Macro, Solid Edge docu-
ment
.asmx: Microsoft .NET Web Ser-
vice file
.asp: active server page
.atn: Adobe Photoshop Action 
file
.au: Audio file, Audacity Audio 
block
.aud: Audio file
.avb: Inoculan Anti-Virus vi-
rus infected file, Microsoft Chat 
character file, Avid Bin File
.avd: Avery Label Pro Data file, 
DOS7 file
.avi: Audio Video Interleaved 
animated file (Windows Video, 
Quicktime, RealPlayer)
.awb: Lavasoft Ad-aware backup 
file, ActiveWords WordBase, 
Adaptive Multi-Rate Wideband 
ACELP codec
.awd: AWD MS Fax, Award 
BIOS file, AWK Language 
Source Code file, Artweaver 
Painting, FaxView document
.awe: Adobe Acrobat Bookmark 
XML file
.awm: Animated Works Movie, 
AllWebMenus, RenderWare 
Language Pack

When you look at a list of files you 
may notice that the file extensions 
are hidden. To find out if they are 
hidden right click “Start” then left 
click “Explore”, then click on a file 
fold on the left side of your screen. 
If you do not see file extensions they 
are hidden you can make then vis-
ible them by following the actions 
below.
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Windows ��
Select “View” then “Folder Op-
tions”.  Select the ”View” tab. Scroll 
down to “Hide file extensions for 
known file types” and uncheck this 
box.
Windows XP
Select “Tools” then  “Folder Op-
tions”. Select the “View” tab and 
scroll down to “Hide file extensions 
for known file types” and uncheck 
this box. Click “Apply to All Fold-
ers”
Vista
Click on the “organize” button. Se-
lect “Folder and Search Options”.  
Select the “View” tab and scroll 
down to “Hide file extensions for 
known file types” and uncheck this 
box. Click “Apply to All Folders”
Obtained from APCUG with the author’s 
permission for publication by APCUG 
member groups.

This article has been provided to APCUG 
by the author solely for publication by AP-
CUG member groups. All other uses re-
quire the permission of the author (see e-
mail address above).




